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Dear Melodyne customer,
You can find the Melodyne Handbook in pdf format in English, German, Spanish,
French and Japanese on our web site: www.celemony.com along with the latest
version of Melodyne and a whole variety of tips and tricks designed to help you
make the best possible use of the program. Check it out. It's well worth a visit.

Lieber Melodyne-Kunde,
Das vorliegende Melodyne-Handbuch finden Sie als pdf in den Sprachen Englisch,
Deutsch, Spanisch, Französisch und Japanisch auch auf unserer Webseite unter
www.celemony.com. Dort finden Sie auch die jeweils aktuellste Version von
Melodyne und viele Tipps und Trick rund um das Programm. Ein Besuch lohnt
sich also...

Estimados clientes.
En nuestro sitio web www.celemony.com encontrará el manual de Melodyne
en formato pdf, disponible en Inglés, Alemán, Español, Francés y Japonés.
Además encontrará la última versión del programa y una amplia variadad de
trucos y sugerencias diseñados para ayudarle a lograr el mejor uso posible
de Melodyne. Compruébelo; vale la pena una visita.

Cher Client Melodyne,
Vous trouverez le Guide d'utilisation de Melodyne au format PDF en Anglais,
Allemand, Espagnol, Français et Japonais sur notre site web: www.celemony.com,
ainsi que la toute dernière version de Melodyne et toutes sortes de trucs et
astuces conçus pour vous permettre de tirer tout le parti possible du logiciel. 
Ne manquez pas d'y faire une visite, vous n'y perdrez pas votre temps.
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Welcome to Melodyne plugin

Melodyne plugin offers you a simple and convenient way of making use of
Melodyne's highly acclaimed technology, which has proved its value in studios all
over the world, within your audio/MIDI sequencer or digital audio workstation (the
'host') and integrate it into your workflow.

Melodyne plugin's specialty is the editing of vocals: no other solution on the
market offers you greater flexibility, sound quality and musicality when it comes to
this sensitive task. There are few professional productions nowadays in which no
Melodyne product is used to optimize the vocals. The listener may not be aware
that any such editing has taken place, but that's precisely what is intended. The
great advantage of Melodyne technology is that it sounds outstanding and totally
natural — even when quite major changes have been made to the pitch or timing. 

You can take advantage of these special characteristics not only for the editing of
vocals but also for that of almost all single-voice instruments. For example, you
can use Melodyne plugin to correct and optimize – or even radically reshape and
create something new from – saxophone, flute, violin, bass or even Jew's harp
recordings. All that is necessary is for the part to consist of a single line with a
recognizable pitch; in other words, a part in which two or more notes never sound
simultaneously and in which there is no overlapping of notes. Since the applica-
tion of reverb can result in notes overlapping, 'dry' (i.e. reverberation free) record-
ings are more suitable for editing with Melodyne plugin.

You can, however, edit percussive recordings as well as melodic ones with
Melodyne plugin. A special algorithm is provided for drum loops, percussion tracks
and the like, and it, too, offers highly flexible and high-quality editing possibilities
that go far beyond conventional slicing.

Melodyne plugin works somewhat differently to conventional plug-ins, so please do
read this manual carefully in order to learn how the software functions – even if
you're already familiar with other Melodyne products.
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The manual is divided into the following chapters:

1. Installation and Authorization
Doubtless you will want to try out Melodyne plugin right away. This chapter covers
the essentials of installing, and authorizing the use of, the plug-in.

2. Introduction: How Melodyne plugin functions
This deals with the plug-in’s essential functioning principles and basic applica-
tions; you should read it before you begin working with Melodyne plugin. Particu-
larly important points ('key facts') are displayed in bold type.

3. Operation
This chapter explains how to use Melodyne plugin.

4. The Interface and Menu Functions
This chapter takes you on a quick tour of the user interface, describing the
function of all the controls and menu items.

5. Tools and Editing Functions
This chapter introduces you to the tools and functions offered by Melodyne plugin
for the editing of audio material.

Here’s wishing you joy and success with Melodyne plugin,
All at Celemony 

Welcome to Melodyne plugin

Melodyne plugin 1.0 user manual
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Melodyne plugin's menu bar

Toolbar and
Inspector area Undo and Redo buttons

The Horizontal Scroll/Zoom slider with
an overview of the transferred segments

Activates / Deactivates
the Note or Scale grid

The Note Ruler

Show / Hide
Notation toggle

The Transfer button and
the Status and Signal display
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Buttons to open the Correct Pitch
and Quantize Time macros

Automation-capable real-time Pitch,
Formants and Volume controls

Quantization On/Off switch and
menu to select quantization factor

The Bar / Time ruler

The Vertical Scroll/Zoom
slider showing the pitches
present at the current position

The Scroll and
Zoom buttons

The editing area
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Sub-tools (for pitch modulation — i.e. vibrato — or drift:
These tools are not context-sensitive: double-clicking on a note
removes the vibrato or drift altogether or restores it.

Formant tool

At the beginning of a note:
alter position (if the Alt key
is held: without snapping)

At the end of a note:
alter length (if the Alt key is
held: without snapping)

Above / below a note: create a note separation (where none exists); otherwise, delete
(double-click) or move one. If the Alt key is held, segments can be created or reunited;
the latter presupposes, of course, that they once belonged together.

At the beginning or middle or a note:
double-click quantize pitch to the nearest suitable
semitone (blue frame)

At the end of a note: control
formant transition to the next note

Main tool

Pitch tool

In the middle of a note:
alter pitch (if the Alt key is
held: in steps of a cent
instead of a semitone)

At the end of a note: control the
pitch transition to the next note.
Double-click: transistion on or off

At the beginning or middle of a note: alter formants
(bear in mind that this is only possible if the ‘melodic’
playback algorithm has been selected). Double-click:
restore formant beams to their original positions

Overview: The tools of Melodyne plugin
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Time tool

Amplitude tool

At the beginning and middle of a note: alter amplitude.
Double click: mute or else unmute notes (toggle)

At the end of a note: control
amplitude transition to next note

At the beginning or middle of a note: alter position of note
(if the Alt key is held: without snapping). Double-click:
quantize to the next suitable time unit (silhouette in the
blue frame)

At the end of a note: alter length
(if the Alt key is held: without
snapping)

Note separation tool

Above / below a note: create a note separation (where none
exists); otherwise, delete (double-click) or move one. If the Alt
key is held, segments can be created or reunited; the latter
presupposes, of course, that they once belonged together.
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1. Installation and Authorization

To begin with, you must install Melodyne plugin on your computer. To do this,
start the installation program that you will find on the CD ROM or that you have
downloaded from the Internet. Please note, that the download area and the instal-
lation CD contain a number of other items that might interest you besides simply
the installation program itself. These are:

– a folder called 'Movies' containing four films to introduce you to Melodyne
plugin and its possibilities

– a folder with small sample arrangements for different hosts that you can use to
try out and learn how to use Melodyne plugin

– a demo version of Melodyne studio

Melodyne plugin is constantly being improved. Please check to see whether a
newer version is available on the Internet than the one on your installation CD.

Installation on the Mac
Launch the installation program.

The installation program 
for the AU plug-in

If you downloaded Melodyne plugin from the Internet, you will already have
selected the appropriate plug-in for the interface you plan to use: VST, AU or
RTAS. If, however, you are installing the software from the CD, by default, plug-ins
for all the available interfaces will be installed. To limit the installation to one (or
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two) interfaces only, click on the Options button in the installation program and
select the interface(s) you plan to use.

The installation program on the CD
allows you to select how many
and which of the plug-in inter-
faces you wish to use

Thereafter, follow the onscreen instructions. Within a few minutes, the installation
will be complete and you can proceed to the authorization stage.

Installation under Windows
Launch the installation program.

If you downloaded Melodyne plugin from the Internet, you will already have
selected the appropriate plug-in for the interface you plan to use: VST, AU or
RTAS. If, however, you are installing the software from the CD, by default, plug-ins
for all the available interfaces will be installed. To limit the installation to one (or
two) interfaces only, click on the Options button in the installation program and
select the interface(s) you plan to use.

Select the interface(s) you wish to use

If VST is the interface (or one of the inter-
faces) you have selected, you will be
invited to choose the VST plug-in folder
for the installation.

Choose the VST plug-in folder you wish to use

Thereafter, follow the onscreen instruc-
tions. Within a few minutes, the installa-
tion will be complete and you can proceed
to the authorization stage.
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After the installation, you must first authorize Melodyne plugin before you can use
it. To do this, open the plug-in in your host. When it is first launched, Melodyne
plugin automatically displays the License window. You can also open this window
manually from the Settings menu should you need to do so at some later date.

Melodyne plugin's
License window

When it comes to entering the requisite data, not all hosts will pass keyboard
input on to Melodyne plugin. If your host won't let you enter data from the
keyboard into the License window, please use the Paste button alongside the
fields: type the requisite information into a text document (or a text field in some
other program); select it, and then use the Copy or Cut command; now switch
back to Melodyne plugin, click the field into which you wish to enter the data
followed by the Paste button alongside it. The text you have copied will now
appear in the relevant field.

There are two different ways of authorizing Melodyne plugin: using the
Challenge/Response procedure and using an iLok copy protection USB dongle,
which you can buy as an option from your local dealer. You can switch at any time
from the Challenge/Response procedure to iLok authorization. After receiving the
iLok license you can still run Melodyne plugin with your existing
Challenge/Response authorization but there is no way to request further License
Keys.

The Challenge / Response procedure authorizes you to use Melodyne plugin on a
particular computer. For this purpose, a special 'Challenge Code' is generated from
the properties of your computer (or rather: from your fixed network identifier);
Celemony will then give you the appropriate "Response Code" with which to

1. Installation and Authorization

Melodyne plugin 1.0 user manual



respond. Once you have entered this, Melodyne plugin will run without limitations
on the computer in question. If you change your computer for another, you will
have to authorize Melodyne plugin again in the same way. 

Authorization using the iLok copy protection dongle results in the authorization to
use Melodyne plugin being stored on the iLok dongle itself. This offers you the
opportunity of installing the plug-in on several different computers and using it on
whichever has the iLok inserted at any given time.

To authorize Melodyne plugin using the Challenge / Response procedure, proceed
as follows:

In the License window, enter your Serial Number, which you will find on the
packaging in which your copy of Melodyne plugin was delivered or on your invoice
(if you purchased the product online).

Please use the Internet to obtain your License Key. If your computer is directly
connected to the Internet, you can access the Celemony web site simply by click-
ing the relevant button in the License window. Once there, enter the necessary
details and click on the Order Key button. You will receive your License Key within
a few minutes via e-mail. If your computer is not connected to the Internet but
you have the use of a computer that is, copy the necessary details using a pencil
and paper.

If you have no access to the Internet, you can order your License Key by post from
Celemony. Just send us a letter in which the User Name you wish to use, your
Serial Number, the displayed Host ID, and your address are all clearly legible. Our
address is: Celemony Software GmbH, Valleystrasse 25, 81371 Munich, Germany.

The Melodyne plugin license belongs in principle to you personally and not to the
computer. If, as a result of changing your computer or components within it, your
Host ID changes, you will have to request a new License Key. If you have any
questions regarding licensing or the License Key, please consult our FAQ at
www.celemony.com/faq (which you can also access via the Help menu within the
program); if you have any problems with licensing, please send an e-mail to our
License Support department at registration@celemony.com.

Please contact us also if you purchased your Melodyne plugin second hand, so
that we can re-register it under your name and send you a new License Key.
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To authorize Melodyne plugin using the iLok, proceed as follows:

– if you do not already have an iLok dongle, purchase one from your local music
dealer (an iLok dongle can store many different licenses);

– if you have not already done so, go to the iLok web site www.ilok.com and create
an account, following the onscreen instructions;

– now go to the Celemony web site, which you can do simply by clicking on the
button in the License window, and order an iLok license from the Licensing
page. There, you will have to enter your Melodyne plugin Serial Number and the
name of your iLok account (which is why it is necessary for you to register your
dongle with iLok before ordering your iLok license from us). Celemony will trans-
fer an iLok license as quickly as possible to your iLok account, as well as
sending you an e-mail to notify you that we have done so;

– as soon as you receive this e-mail from Celemony, visit www.ilok.com again and
log in. You will find a Melodyne plugin license has been deposited to your
account; to transfer this to your dongle, follow the onscreen instructions; 

– you can now run Melodyne plugin using your iLok for authorization. To do this,
launch the plug-in and select iLok instead of Challenge / Response in the
License window. You will now be able to use Melodyne plugin on your computer
without going through the Challenge / Response procedure, provided you first
insert the iLok dongle into a USB port.

If you have any questions concerning, or encounter any problems with, the iLok
dongle, please visit the iLok page in the Licensing area of our web site,
www.celemony.com, where you will find detailed information on this subject.

Are you up-to-date?
Melodyne plugin is constantly being improved. Please check to see whether a
newer version of the program than the one on your installation CD is available. If
you have already installed Melodyne plugin, you can do this simply by clicking the
Check for Updates command in the Help menu. Otherwise visit
www.Celemony.com. Please note that you can also access the Celemony web site,
our Support department, or our FAQ pages directly from inside the program —
again, via the Help menu.

1. Installation and Authorization
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2. Introduction: 
How Melodyne plugin functions

Melodyne plugin does not work in real time like a conventional effects plug-in. In
other words, it does not process the audio signal at the same moment it receives
it, the way an echo or chorus effect does; for it to work in such a way is logically
impossible, since Melodyne plugin can also edit the timing of notes (their position
and length), which it can obviously only do once they are all 'there' and it has had
a chance to study them; despite its advanced technology, Melodyne plugin cannot
look into the future! We have therefore adopted a different approach that allows
you to take advantage of Melodyne plugin’s full range of editing possibilities,
which go way beyond simple pitch correction, and for this it is necessary for it to
analyze the material in advance and recognize (or 'detect') the individual notes.
This brings us to the first of our key facts:

If you want to edit a piece of audio material using Melodyne plugin, you must 'play it
through to it' first. As you do this, the plug-in will record the passage, analyze it, and
then display it in its own editor so that you can begin work.

Only by playing it through in this way beforehand do you make it possible for
Melodyne plugin to shorten, lengthen and quantize notes; modify their volume
individually; and do other things besides. With a plug-in working entirely in real
time, such things would be impossible (in the absence of a time machine…)
without increasing the overall latency of the host to an impracticable level through
the use of a correspondingly large look-ahead buffer.

Once you've played the material through to the plug-in, or rather, transferred the
material to the plug-in, thereafter it does work in real time: if you move a note to a
different pitch in the Editor, alter its length or use the automatic pitch- or timing-
correction functions, the changes are displayed, and can be heard, immediately –
i.e. without any latency at all – in the context, naturally, of your running arrange-
ment.
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You know now that audio material requiring editing using the plug-in must be
transferred to it first. Melodyne plugin records these signals and stores them on
your hard disk. It is these files, created by Melodyne plugin – not the audio files
created by your host – that form the basis for all editing done in the plug-in.

But why doesn't Melodyne plugin simply access the existing audio file used by the
host? Unfortunately, it would serve no useful purpose to reveal to the plug-in the
location of this file, since the file in question has no idea which parts of it are
played back when and where, which have been duplicated, nor which have been
deleted or had special playback parameters applied to them; and for Melodyne
plugin to make any kind of intelligent use of it, it would need to know all of these
things and reproduce in its own editor the results of the editing you have already
done in the host. There's no alternative, then, but to transfer the material.

Melodyne plugin and the host
The question that arises now is: how do the audio material on the host track and
the material transferred to Melodyne plugin interact. To this, there is a simple
answer: our second key fact:

In those parts of the timeline where audio has been transferred to Melodyne plugin and
notes are visible in its editor, you will hear the plug-in and not the host track;
conversely, in those parts of the timeline from which nothing has been transferred to
the plug-in or in which no notes are visible in its editor, you will hear the host track not
the plug-in.

You can transfer to the plug-in as many passages from as many different parts of
the host track as you like; the plug-in retains the overall picture. Wherever there
are notes in its editor, it plays them back and at the same time mutes the host
track; in all other places, it is the plug-in that is silent, allowing the host signal to
pass. You can think of it, if you like, as an automatic railway switch (or ‘point’)
that gives priority to the plug-in whenever it has notes to play, but allows the host
signal to pass at all other times.

2. Introduction: How Melodyne plugin functions
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An audio segment is transferred to Melodyne plugin

Melodyne plugin switches automatically between signals from the host track and those of the plug-in

This sample-accurate mechanism makes it possible for you to transfer single notes
from the host to the plug-in if you so desire: to do this, transfer to the plug-in a
short passage containing the “wrong note”; then delete all the notes around it, so
that only the note you wish to correct remains. When playback reaches the note in
question, Melodyne plugin will switch from the output of the host track to its own
output, and then back again as soon as the note ends. In other words, only the
note you wish to correct will be affected; the others will play back from the host
track exactly as before.

Now that you know how Melodyne plugin functions and the way it switches
automatically between its own signals and those of the host, a number of
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questions arise concerning your own 'working strategy', since there are now two
'audio levels': the original signal on the host track and the passages you have
transferred to the plug-in. What happens if, after transferring a passage to the
plugin, you modify, delete or re-record it in the host? The answer to that question
constitutes our third key fact:

Melodyne plugin has no way of knowing when something changes on the host track.

If you rearrange the material on the host track and these changes affect parts of
the timeline where there are notes in the plug-in, you will have to make correspon-
ding changes to the material in the plug-in; otherwise, the plug-in will switch at
the wrong moment from the host’s to the plug-in’s signal, and you will hear the
notes of the 'old' arrangement that are still in the plug-in. The same applies if you
delete the material on the host track or replace it with new material.

Why can't the plug-in register changes made to the host track? The reason is that
the commonly used plug-in interfaces do not support the type of information
exchange (between plug-in and host) that this would require. The various plug-in
interfaces are simply designed to route audio from the host to the plug-in and
back, along with some rudimentary information needed for the purpose of synchro-
nization. Melodyne plugin makes skillful use of the various plug-in interfaces to
allow for a very advanced type of audio editing that was not envisaged when they
were conceived, but there remain technical and conceptual limitations in the
design of the plug-in interfaces that create obstacles not even Melodyne plugin
can surmount. 

Working strategies 
To work as smoothly as possible and without confusion with the two audio signals
(the host track and the material transferred to the plug-in), two basic strategies
suggest themselves immediately; it is not necessary to adopt either of them
slavishly, but being aware of them should help you optimize your workflow with
Melodyne plugin. 

Suppose you have recorded some vocals on one of the tracks of the host and wish
to make corrections to certain passages or edit them in some other way. Not all
bars, we will assume, are yet in the positions they will eventually occupy: you may
wish, for example, later to copy the vocals from the third refrain to the first; in
other words, the track is not yet fully arranged but is simply functioning as a kind
of container for the various takes, which you have not yet sorted, cleaned up, and
moved to their final destinations.

2. Introduction: How Melodyne plugin functions
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One approach would be to transfer the audio material on the track in its entirety to
Melodyne plugin, where you could remove the mistakes and optimize the material.
Once you had done this, you could 'bounce' the results to the hard disk and simply
replace the old audio file in the host track with the newly created one. You could
then deactivate Melodyne plugin, as it would by that time have served its purpose,
with the changes made ‘fixed’ in a new audio file. If you were working in this way,
you could then continuing copying and moving segments of the (now optimized)
vocals on the host track until everything was in the desired place. 

Note: the 'Bounce', 'Render' or 'Audio Mixdown' function (the name varies from
host to host) results in a new audio file (or files) being created by the host on your
hard disk from the signals of one or more tracks – after processing (including, in
this case, the changes introduced by Melodyne plugin) has been applied to them.

The second approach involves postponing the use of Melodyne plugin until after
you have arranged the track: Begin by going through your vocal recordings, remov-
ing the bad takes, and copying and moving the good ones to the right places. Only
then, when the arranging process is complete, do you transfer the track – or rather
those parts of it that require optimization – to the plug-in. Since the material on
the track has already been arranged, there is not the same danger here of finding
your work with the plug-in being outdated by changes to the arrangement made
later in the host. (Remember; any such changes must be duplicated within the
plug-in, by moving the affected notes to the same positions in the plug-in’s
timeline as they occupy in that of the host). Whether you now, with this second
approach, bounce the host track and the plug-in track to create a new audio file,
or wait and allow the plug-in to decide which source to use and when, is a matter
of personal preference. If you want to transfer the song to another computer on
which Melodyne plugin is not installed, then, naturally, you do have no choice but
to bounce it. The same applies if the burden on your computer’s CPU is reaching a
critical level, the reason being that playing back a bounced track requires far less
processing than playing back an unbounced one.

A hybrid approach might be to begin by transferring the entire track with all its
takes to Melodyne plugin, where in a single pass you could correct the worst of the
errors using the pitch- and timing-correction macros, before rendering the results
to the host application. If at a later stage you wished to return individual passages
to Melodyne plugin for ‘microsurgical fine-tuning’, it would simply be a question
of transferring them a second time to the plug-in using the same procedure as
before.
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The approaches we have outlined serve simply to avoid potential confusion caused
by the fact of there being two audio levels: that of the host application and that of
the plug-in. You are free, of course, to transfer only the passages requiring editing
from the host track to the plug-in, and work with the combined signals of the host
track and the plug-in. If you do so, however, remember that any changes made to
the audio material on the host track must be duplicated in the plug-in; alterna-
tively, you could simply delete the passages in question in the plug-in and transfer
the new versions from the host to the plug-in for further editing.

The peculiarities of hosts
We have already observed that Melodyne plugin can do nothing about the concep-
tual and technical limitations of the plug-in interface; the same goes for the
peculiarities of certain host applications. Since Melodyne plugin runs within the
host environment as a plug-in, it is dependent upon it and subject not only to the
limitations imposed by the interface but also to whatever additional limitations
result from the peculiarities of the specific host. This brings us to our fourth key
fact:

Melodyne plugin can only do as much as the host will let it. If, for example, the host
only processes plug-ins only in those places in the timeline where there is actually
audio on the host track (as is the case with Logic and DP), these limitations are
inevitably reflected in the way they interact with Melodyne plugin.

If your host falls into this category, it can happen at times that you see notes in
Melodyne plugin and ought therefore to be able to hear them during playback, but
in fact hear nothing, the reason being that there is no audio on the host track at
this point in the timeline, either because you moved the passage in question to a
different part of the song after transferring it to Melodyne plugin or because you
simply deleted it. In such cases, there’s a simple workaround: copy a piece of
‘mute audio’ (for example, a piece of bounced audio containing only silence) to
the relevant part of the host track; this will force the host to process the plug-in.

Depending upon which application you are using as a host, you may encounter
other limitations, including some that appear overnight, or rather, when you
update the host; updating your host software may even have the opposite effect,
causing limitations that were there previously to disappear. Celemony tests
Melodyne plugin on a large number of host applications, so as to be able to offer
tips and workarounds for whatever problems are encountered. Since this is an
ongoing process and the information provided relies upon the assumption that you
will be constantly updating your software to take advantage of the latest improve-
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ments, this handbook is obviously not the best place to deal with it. Instead, you
will find in the FAQ section of the Celemony web site (www.celemony.com
/faq_plugin) a constantly updated fund of information – sorted by host application.
If ever you have the feeling, then, that something isn’t functioning quite as it
should, that’s the first place to look for a solution: the section devoted to your host
application in the FAQ.
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3. Operation

You should by now have an understanding of the way Melodyne plugin functions
as well as an idea of how to make the most effective use of it. In the following
chapter, we will look a little more closely at the practical use of Melodyne plugin,
before examining the user interface and the functions to which it offers access.

Note: please remember that Melodyne plugin does not respond to keyboard
commands; these always affect the host! If you wish to delete a note from inside
the plug-in, you have to do so using the Delete command in the Edit menu rather
than the [Delete] key of your keyboard – otherwise, what you will in fact delete is
the currently selected object in the host application. The same goes for the Undo
and Redo functions; the conventional keyboard shortcuts for these will cause the
host not the plug-in to Undo or Redo its last action. If you wish to use the Undo or
Redo functions within Melodyne plugin, you can only access these commands
through the Menu or via the corresponding buttons on the plugin surface. Other-
wise the results will not be those you expect.

To use Melodyne plugin to edit the audio material on one of the tracks of your host
application, proceed as follows:

1) Load Melodyne plugin into the track as an insert effect. If possible select the first
insert slot, relegating whatever other effects you wish to use to a later point in
the signal chain. Melodyne plugin works best with cleanly recorded, 'dry'
material; for this reason, it is best to avoid placing effects in front of it. The
most problematic effects in this respect are reverb, echo, chorus and the like,
since they make it more difficult – or even impossible – to detect the notes in
the audio material. EQ and compression pose less of a problem, but you should
still place them after Melodyne plugin in the signal chain, because otherwise,
when the results of your editing are transferred, the EQ and/or compression will
be transferred at the same time, which means you will no longer be able to
change them.

3. Operation

Melodyne plugin 1.0 user manual



2) Position the host's playback cursor at the beginning of the notes you wish to edit
and click on the Transfer button at the top left of the Melodyne plugin interface.
The three arrows in the key will flash red to indicate that Melodyne plugin is
ready to record (i.e. armed for recording).

The Transfer button arms 
Melodyne plugin for recording

Note: The first time you use Melodyne plugin, you will be asked to select a tempo-
rary recording folder, which will be the one Melodyne uses to store the passages of
audio it records. You can select a different temporary folder later using Melodyne
plugin's Preferences dialog. If you like, you can also move the data in a project
recorded by one instance of the plug-in to an individual folder (preferably in your
project folder) and cause further recordings within this instance to be written to
this folder. Doing this is useful if, instead of rendering the material immediately,
you wish to pass on a project with Melodyne plugin open along with the material
already transferred to it. You will find more information about file management in
the section describing the menu commands.

3) Commence playback in the host, in order to transfer the material to the plug-in.
The arrows in the Transfer button will now flash in a chase pattern, and the
orange color in the Editor will indicate that recording is in progress. You can
also activate the Transfer button while the host is already running, in which
case Melodyne plugin will switch instantly to record mode.

4) Stop playback in the host or press the plug-in's Transfer button again to stop the
transfer. Melodyne plugin will now analyze the transferred material, displaying a
progress bar as it does so. As soon as the analysis is complete, the notes will be
displayed in the form of 'blobs' in Melodyne plugin's Editor.

Depending upon its characteristics, Melodyne plugin will interpret the material as
either ‘melodic’ or ‘percussive’ and select automatically the corresponding
playback algorithm as well as the appropriate way to display the material in the
Editor. If the material is melodic, the blobs are shown on different vertical
positions, indicating their individual pitch.
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A melodic audio segment in the Editor

With percussive material, on the other hand, the blobs are displayed on a standard
note, since no pitch has been detected; for the same reason, there is also no pitch
curve.

A segment containing percussive material in the Editor

The editing possibilities for melodic and percussive material are somewhat differ-
ent. You can read more about these in the chapter dealing with tools and editing
functions.

5) Transfer any other passages that require editing from the host track to the plug-in.
You can transfer material from the host to the plug-in in short segments – a
little bit here, a little bit there – and Melodyne plugin will record each time a
new segment at the correct point in the timeline, overwriting any existing
recordings where they coincide. You need, therefore, to take care not to erase
accidentally, by a new transfer, work you have already done. If that does
happen, however, you can use the Undo function in Melodyne plugin's Edit
menu or the corresponding button; this will undo the transfer, restoring the
previous contents of the plug-in.

3. Operation
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Note: if your song contains complex time signature changes and you transfer
material that comes after these changes to the plug-in, it can happen that the bar
ruler in the plug-in will no longer correspond to that in the host and the bar lines
will appear in the wrong places – even though the transferred notes still sound
fine. The solution is to transfer to Melodyne plugin all the passages containing a
change of time signature – even if you don't plan to edit them in any way (you can
delete the notes they contain immediately if you like). Simply by transferring these
passages, you will let Melodyne plugin know about the changes in time signature,
enabling it to place the remaining bar lines in the same places as those in which
they appear in the host. If your host is one of those referred to in the second
chapter that only process plug-ins in those places where there is audio present on
the track, and this is not the case at one of the moments where a change of time
signature occurs, use the trick we suggested earlier: copy 'silent audio' to the bars
containing the change of time signature.

6) Edit the transferred material until you are satisfied with the results. A description of
the tools and functions Melodyne plugin offers for doing this appears in a special
chapter entitled 'Tools and Editing Functions'.

A tip: before you begin editing, pay carefully attention to the beginnings and
endings of the segments you have transferred. You will remember that at such
moments, Melodyne plugin switches playback between the host’s output and its
own; if you have begun or ended the transfer in the middle of a note, this switch-
ing will occur in the middle of the note, the result being perhaps an unwanted
click, which you would not have got if you had begun and ended the transfer
between notes. The best idea, therefore, is to begin the transfer slightly before the
passage you mean to edit and end it slightly after. You can then simply delete the
‘overhanging’ notes, thereby ensuring that the entry to, and exit from, the passage
to be edited will come at precisely the right moments. 

7) 'Bounce' or 'Render' the results of your editing. This is the final step in the use of
Melodyne plugin, though it is one that you are not obliged to take. The
'Bounce', 'Render' or 'Audio Mixdown' function (the name varies from host to
host) results in a new audio file (or files) being created by the host on your hard
disk from the signals of one or more tracks – after processing (including, in this
case, the changes introduced by Melodyne plugin) has been applied to them. 

If you have used Melodyne plugin on a track and then bounce this track (or the
part of it you have edited), the result will be a new audio file containing the edited
version of the material. You can then move this audio file to the original host track
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at the same point in the timeline as the bounce occurred. In this way, you will
replace the passage originally transferred to Melodyne plugin by a new file that
reflects the results of your editing. Now you can – and should – deactivate
Melodyne plugin in this track, as it has completed its work and is no longer
needed, and continue working as before with the audio regions of your host.

We mentioned above that step 7 is not obligatory: instead of bouncing, you can
simply allow Melodyne plugin to carry on switching wherever necessary between
the output of the host track (or tracks) and its own output, right up to the master-
ing stage. Of course, if you are planning to pass on the song to someone else or to
transfer it to another computer on which Melodyne plugin is not installed, then
you must bounce the track(s) from which you have transferred material to
Melodyne plugin. You may want to do this anyway in order to reduce the load on
the CPU of your computer, or to bring your work with the plug-in to a conclusion
and make the results of your editing ‘permanent’.

Tip: trying out different tempos
Melodyne plugin offers you a simple way of experimenting with different tempos
during the composition phase to see which feels best. To do this, insert one
instance of Melodyne plugin into each of the audio tracks of your production and
transfer the entire contents of the track to it. Now, you can speed up or slow down
the playback at will and your audio tracks will follow every change just as if they
were using MIDI- or software instruments. You need, however, to bear the follow-
ing in mind:

It is a good idea to investigate the tempo at a relatively early stage in the produc-
tion, when, for example, all you have recorded (apart from the MIDI tracks) are a
handful of audio tracks: the bass, a drum loop, and the lead vocals, for example –
the fewer instances of the plug-in you use, the less the load on the CPU of your
computer.

The tempo changes will only affect the material transferred to the plug-in, not the
material on the host tracks, so the two will be out of sync; this can lead to optical
confusion (what you see will not be what you are hearing) and in pauses between
the notes of the transferred material, the host tracks will burst in. To avoid this
happening, replace the original tracks in the host with silent audio. With certain
hosts, such as Logic (as explained in Chapter 2), this silent audio must run the
length of the entire song; otherwise, as we have already explained, the absence of
audio at any point in the host track will mute the playback from the plug-in.
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Once you have settled on a new tempo, it is a good idea to bounce all the audio
tracks individually and replace the silent audio on the host tracks with the
bounced files. Once you have done this, the waveforms displayed on screen will
once again match the audio you are hearing; in other words, the display and the
playback will again be in sync.

If you want to make regular and intensive use of Melodyne to experiment with
different tempos, we should in all fairness point out that the multi-track editions
of Melodyne (Melodyne cre8 and Melodyne studio), when connected via the
MelodyneBridge or ReWire to the host, offer an even faster and more intuitive way
of doing this.
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4. The Interface and 
Menu Functions

Overview
The Menu bar is at the top of the Melodyne plugin window. A tour of the various
menus follows the introduction.

Beneath it on the left of the screen is the Transfer pane containing the Transfer
button, a toggle used to activate and deactivate the transfer of data to the plug-in,
the functioning of which was described in Chapter 3. To either side of it are level
display meters marked ‘Host’ and ‘Plugin’. If what you are hearing is the signal
from the host, the word ‘Host’ will be illuminated in green and the meter beneath
it will indicate the level of the signal; if, on the other hand, what you are hearing
is the signal from the plug-in, the word ‘Plugin’ will be illuminated in green and
the meter beneath it will indicate the level of the signal. This enables you to tell at
a glance which signal you are hearing at any given instant. Beneath the Transfer
button is a line of text that indicates the current transfer status.

The second frame from the left contains the tools for editing the audio material as
well as the Inspector, which displays information about the selected notes and can
be used to enter new values. The button that is detached somewhat from the
others and displays a spanner is used to activate Correct Detection mode, in which
you can move any notes the pitch of which Melodyne plugin has failed to identify
correctly (usually by placing them one or more octaves too low or too high) to the
correct pitch. You will find more detailed information about Correct Detection
mode in Chapter 5.
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The third frame from the left contains the multilevel Undo and Redo buttons,
each of which duplicates the functions of the command of the same name in the
Edit menu. The Undo and Redo buttons are grayed out when there is nothing to
undo or redo.

The next frame contains the buttons used to invoke the automatic Correct Pitch
and Quantize Time macros. These open modal windows, which means you can no
longer select notes or use any of the other functions of the plug-in for as long as
they remain open. The effects of any parameter changes made using the windows
are displayed and heard immediately.

You will find more detailed information regarding the use of these macros in
Chapter 5.

The Correct Pitch panel

The Quantize Time panel
used for correcting timing
and re-quantizing notes

The pane on the right contains rotary controls for the real-time control of pitch,
formants and volume level; these can be automated in the host or assigned to a
MIDI fader box (or both). Right-clicking on the Pitch or Formants controls opens a
context menu from which you can select the control range from three options: ±2,
±12 or ±24 semitones. These controls offer you swift access to the most impor-
tant parameters of the material, but they are not ‘editing controls’: in fact, they
have no affect upon your work in the Editor or the displayed state of the notes.
What they do is add or subtract something in real time to the values set in the
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Editor, treating all the notes in the plug-in in the same way. Please note that with
percussive material (or to be more precise: when the Percussive playback
algorithm is selected) the transposition of formants is not possible; the Formant
controller is therefore deactivated.

Melodyne plugin's menu
Melodyne plugin possesses its own small menu bar offering access to various
settings and editing functions. There are six menus in all: Settings, Select, Edit,
Algorithm, View and Help.

The Settings menu
The Scale command opens a small modal window
from which you can select from a list a tone scale, 
its tonic (the first note of the scale), and the overall
tuning.

Selecting a scale affects what happens when you move notes vertically and the
Scale Snap function has been activated in the bottom left-hand corner of the
window; when Scale Snap is selected, the Note ruler to the left of the Editor alters
its appearance and you can select a tonality by clicking its tonic in the ruler, and
toggle between major and minor by shift-clicking on it.

This is where you activate 
the Scale Snap function
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The commands Move/record Files to… and Trash Recorded files… help you to
manage the audio files created by Melodyne plugin. The first time you launch the
plug-in, you are asked to select a temporary recording folder; this is where
(without asking, in future) Melodyne plugin will store all the files containing the
transferred audio. If you wish to save the data recorded by one instance of the
plug-in to an individual folder with a view to transferring the whole project (includ-
ing this data) to another computer, select the command Move/record Files to…. A
file selection box will appear allowing you to select a storage location. When you
confirm your choice, the recordings already made using that instance of the plug-
in will be transferred to the selected folder and all subsequent files created by it
will be stored there as well. After selecting a new recording folder, be sure to save
your project, in order to fix the altered references to the new storage location for
the files.

The command Trash Recorded files is there to help you tidy up. It is particularly
useful when you have finished work on a particular track and bounced the results
to a new audio file with which you will replace the original material on the host
track (you will find further information about this manner of working in Chapter 3).
Choose Trash Recorded files... before removing Melodyne plugin from the track. A
modal window will appear containing a list of all the audio segments transferred to
the current instance of the plug-in.

The list of the trans-
ferred audio segments

Beside each segment, you will see an indication of whether or not it is used by the
plug-in or not (as will be the case if you have already deleted it from the plug-in –
the notes are no longer in the plug-in but their audio file is, however, still on your
hard drive). You then have the choice of removing either all the files from disk
which have been created by that instance of the plug-in or only those which are no
longer in use. By making regular use of this function, you can ensure that your
recording folder does not consume an unnecessarily large amount of space on your
hard disk by deleting from it all those files and snippets of files that are no longer
needed. Please note, however, that deleted files cannot be recovered.
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The Preferences... command also opens a small modal window, in which you will
find three options; with the first, you can select a folder to use as a temporary
recording folder, with the second, determine the size of the plug-in window, and
with the third you choose your favorite language (please note that changing the
language will only take effect when you shut down and restart your host).

The Preferences
window

You can select between three standard window sizes as well as select a user-defin-
able size. Please note, that the plug-in window must be closed and then reopened
before any changes will take effect!

Finally, the License… command opens the License window. This is where you
authorize the plug-in for your computer; a procedure described in Chapter 1.

The Select menu
In this menu, you will find various self-
explanatory commands relating to the
selection of notes. A tip: if you wish to
delete a passage that you have only just
transferred to the plug-in, it is not neces-
sary to select all the notes followed by
Delete. Far simpler is to click the Undo
button.
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The Edit menu
This menu contains the commands Undo
and Redo, which you can also invoke by
clicking the corresponding buttons on the
plugin's surface.

The next command is used to delete
selected notes. Remember that when you
delete a note from the plug-in, you will
hear the host track once more at that point
in the song. If what you really want is for
there to be a rest (i.e. silence) at that
point, you should mute the note in
question rather than deleting it. To do this, double-click on the note with the
Amplitude tool; you will find more information about muting notes in Chapter 5.

Note: please remember that Melodyne plugin does not respond to keyboard
commands; these always affect the host! If you wish to delete a note from inside
the plug-in, you have to do so using the Delete command in the Edit menu rather
than the [Delete] key of your keyboard – otherwise, what you will in fact delete is
the currently selected object in the host application. The same goes for the Undo
and Redo functions; the conventional keyboard shortcuts for these will cause the
host not the plug-in to Undo or Redo its last action. If you wish to use the Undo or
Redo functions within Melodyne plugin, you can only access these commands
through the Menu or via the buttons on the plugin's surface. Otherwise the results
will not be those you expect.

The remaining commands in the Edit menu are contained in sub-menus that
correspond to Melodyne plugin’s tools. These commands are dealt with in the
section devoted to tools in Chapter 5.

The Algorithm menu
From this menu you can select whether the
playback algorithm for Melodic or Percussive
material should be used; your choice will affect
all the notes in that instance of the plug-in.
Initially, Melodyne plugin determines automati-
cally (based upon its own analysis of the
material) which of the two algorithms is likely to be the more appropriate, but you
can override its decision, if you wish, using this menu. Experimentation is likely to
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prove most fruitful when the material is both percussive and melodic in character,
such as a slapped bass line or scat vocals.

The algorithm for melodic material displays the transferred notes in such a way as
to permit you to read their pitch from the note ruler; it also displays a pitch curve
and allows you to transpose the formants. The algorithm for percussive material,
on the other hand, displays all the notes at the same pitch, since with percussive
material, the sounds generally have no recognizable pitch; for the same reason,
this algorithm displays no pitch curve. The Percussive algorithm is designed to
preserve the transients of the material and its timing even after quite drastic
changes have been made. Unlike the algorithm for melodic material, the Percus-
sive algorithm does not allow you to transpose formants.

The View menu
This menu contains three options
relating to the plug-in’s display.

If you select Autoscrolling, the
display in the Editor will follow the
current song position at all times –
unless, of course, you scroll the display manually or drag a note, in which case the
auto-scroll function will be temporarily disabled (to allow you more time to
examine the passage in question or perform the desired edit). As soon as you stop
and restart the playback of the host, the auto-scroll function will be reactivated.

The two other options relate to the display of the pitch curve and that of the note
separations (the vertical grey lines between the note blobs); you can select
whether you wish to see these or not. Please note, however, that the pitch curve
will be displayed regardless of your selection here whenever the Pitch, Formant or
Note Separation tools are selected the note separations will be displayed regard-
less of your selection here whenever the Main or Note Separation tools are
selected
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The Help menu
The Help menu affords direct access to the
documentation of the plug-in as well as to a
number of web pages:
– the Celemony Frequently Asked Questions

(FAQ) page
– the Celemony Support page to which you

can turn for aid in the event that you
cannot find the answer on the FAQ page 

– the home page of the Celemony web site
– the Search for Updates command checks

the Internet to see whether a later version of Melodyne plugin than the one you
are using is available

– the command IMSTA takes you directly to the web site of the International
Music Software Trade Association, of which Celemony is a member and which
exists to fight software piracy.

Other elements of the interface

Select Time Grid
When moving notes horizontally or altering their length, a grid selected from a menu
at the right-hand end of the Bar ruler can influence the behavior of the plug-in.
Clicking briefly on this button toggles the Snap To Grid function on and off, whilst
holding the mouse button down for slightly longer opens a dropdown menu, from
which you can select the grid resolution – the options being any of a number of note
values or else Seconds. Please note, however, that depending upon the zoom resolu-
tion of the display, movements up to four times finer than the selected grid resolu-
tion are possible. If you have selected “1/4” for example and zoom far enough in,
you will be able to move notes by as little as “1/16” at a time.

Note: if you hold the Alt key whilst dragging notes, the snap function will be
temporarily deactivated.

The Time Grid menu
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Select Pitch grid
When moving notes vertically (i.e. transposing them), another grid comes into
effect, and this is selected from the bottom left-hand corner of the plug-in
window.

The Pitch Snap menu

Here, the options are threefold:

No Pitch Snap – notes can be transposed freely in terms of pitch
Note Snap – notes will snap to the nearest semitone
Scale Snap – notes will snap to the nearest tone of the current scale as defined
from the Settings menu. To determine a scale, select its first note (the tonic) by
clicking the relevant note in the Note ruler in the left hand margin of the display,
and shift-click on it to toggle between major and minor.

Note: if you hold the Alt key whilst dragging notes, the snap function will be
temporarily deactivated.

Show / Hide Stave
If you wish to see the notes displayed in conventional notation (on a stave) and
edit them from a display in this format, click the ‘treble clef’ icon at the left-hand
extreme of the Bar ruler. You can drag notes on the stave upwards or downwards to
transpose them. Click the icon a second time to hide the stave.

The Show / Hide Stave button
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Zooming and Scrolling
Melodyne plugin offers you a number of different ways of determining what part,
and how much, of the material is displayed in the Edit window at any given
moment. 

The icons in the bottom right-hand corner of the screen can be used to scroll and
zoom the display; to scroll it, use the Arrow icons; to zoom in or out (i.e. increase
or decrease the display resolution), use the icons with the serrated motif. 

The Scroll and Zoom icons

Melodyne plugin also offers you horizontal and vertical scroll bars, which can also
be used to alter the display resolution: drag the middle of the sliders to scroll the
display and the sides of the sliders to zoom in or out. You will see in the slider a
miniaturized representation of the pitches or note positions; material that lies
outside the pitch range at the selected zoom resolution (or that would do if you
scrolled there) is grayed out. 

The horizontal and 
vertical Zoom / Scroll sliders

Drag the centre of the slider to
move the display window and
the sides to increase or
decrease the display resolution

Finally, there are two additional tools that allow you to scroll or zoom the display
horizontally and vertically at the same time. If you hold down the Command key
(the Apple key on the Mac; the Ctrl key on the PC), the cursor changes to a hand
that can be used to move the focus of the Editor’s display window in any direction.
If at the same time you hold down the Alt key, the cursor changes to a magnifying
glass that you can use to increase or decrease the display resolution by clicking
and dragging upwards or downwards (to change the vertical resolution) and/or to
the side (to change the horizontal resolution).
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5. Tools and Editing Functions

In this chapter, you will learn about the various editing options that Melodyne
plugin offers and how to use the corresponding tools and functions.

If confusion and frustration are to be avoided, it is not merely advisable but of
crucial importance that you understand how Melodyne plugin works before experi-
menting with it; if you have not already done so, please read Chapter 2, which sets
out the basic principles.

To try out the techniques described below, you must first transfer an audio file to
the plug-in; how to do this is explained in Chapter 3. To begin with, choose a
recording with a purely melodic content, such as a solo voice or saxophone or
something of that kind, as it is with this type of material that you can most easily
explore Melodyne plugin's editing functions. 

Included with Melodyne plugin, you will find a folder containing a number of
sample audio files; these are suitable for use when trying out the functions we are
about to describe, so if you have no other material to hand, just use them.

As soon as you transfer an audio segment from your host, Melodyne plugin will
analyze it; this analysis (which we call 'detection') is the foundation for the
outstanding editing capabilities offered by the program. A progress bar provides
feedback on the progress of the analysis.

For your information, Melodyne plugin stores the information gleaned from its analy-
sis in a separate file in the same folder as the recorded audio file (which is generally
the temporary recording folder you selected the first time you launched the plug-in)
and has the same name but with the filename extension “.mdd".
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Once the process of analysis is complete, the file is displayed in the editing area –
complete with Melodyne’s famous blobs indicating the exact pitch center and ampli-
tude envelope of each note. If the material transferred is purely melodic, the blobs
will be displayed at heights that vary depending upon their pitch; you can discern
the pitch of each note by referring to the Note ruler in the left-hand margin. If, on
the other hand, the material has been identified as percussive or 'non-melodic', the
blobs will be displayed in a horizontal line and there will be no pitch curve. 

Now you can begin editing.

Editing the pitch with the Main tool
Make sure that the tool with the standard, arrow-shaped mouse pointer is
selected; this is what we call the 'Main tool' in Melodyne plugin.

The Main tool

Move the mouse pointer in the editing area to the center of one of the blobs. You
will notice that the appearance of the pointer changes as it transforms into the
Edit Pitch tool: click on a blob and drag it up or down; when you release the
mouse button, you will find that you have raised or lowered the pitch of the note.
Using this drag ‘n’ drop method, you can transpose notes upwards or downwards
by any number of semitones, just as if you moving MIDI notes in a sequencer. You
aren’t, of course, obliged to move notes one at a time: you can select an entire
phrase and transpose it upwards or downwards in the same way, by rubber-
banding multiple notes or by holding the Shift key as you select them; in either
case, when you then move one of the blobs, the others follow the movement.

Clicking on the center area of a blob and
dragging it up or down raises or lowers
the pitch of the note

Tip: when you have transferred a fairly long file, the blobs may be too small for you
to be grabbed and moved easily in the manner described; in this case, click on the
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horizontal and vertical zoom icons in the bottom right-hand corner of the screen,
or use the Scroll/Zoom sliders in the scroll bars, to increase the display resolution.
With the Navigation tool (the "Hand"), which you activate by holding down the
Command key, you can grab the screen content and move it. You can also use this
tool for zooming by holding down the ALT key in addition, before or during the
movement; whereupon the horizontal and/or vertical display resolution will
increase or decrease. 

When you transpose a note or series of notes over some interval larger than a
semitone — a fifth, say — you will notice that the characteristic timbre of the
source, be it a voice or instrument, is preserved: instead of the dreaded
‘Chipmunk’ or ‘Darth Vader’ effects of conventional transposition tools, you get
something that sounds remarkably similar to the same voice singing, or the same
instrument playing, in a different register. If you are familiar with the acoustic
principles at work here, you will have guessed why this is so: when it transposes
the sound of a voice or instrument, Melodyne plugin leaves the formants (its
acoustic fingerprint, if you like) where they are, thereby obtaining a far more
realistic effect than conventional pitch shifters, which simply increase or decrease
the frequency of the entire waveform, moving the formants into the bargain.

Note: it can happen on rare occasions that the sound characteristics of a record-
ing prevent Melodyne plugin correctly identifying the intended pitch of a note,
usually confusing it with the same note an octave higher or lower. In such cases,
there is an easy way of manually correcting the detection, but we will come to it
later in this chapter.

Look for a moment at the background of the editing area. You will notice that it is
made up of horizontal stripes (or "lanes")  each of which represents the note with
which it is aligned in the left-hand margin (or "Note ruler"). If you look more
closely at the note-blobs of your audio recording, you may perhaps notice that not
all the notes are exactly in the middle of their lanes; some may even lie on the
boundary between adjacent lanes.

The intonation here is poor
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This is where Melodyne's fine-tuning option comes into play: aim the pointer once
more at the middle of the blob, but this time hold down the Alt key before clicking
and moving the note with the button held down. In this way, instead of moving it a
semitone at a time, you can fine-tune the note and move it to the middle of the
desired lane – i.e. to exactly the correct pitch.

The grid for editing pitch
In the bottom left-hand corner of the plug-in window, you will find a button that
allows you to activate the pitch-editing grid. If you click on the button and hold
the mouse key down, a menu will open offering a choice of three options:-

– No Pitch Snap: you can move the notes freely, exactly as though you were
holding down the Alt key with the grid active

– Note Snap: you can move notes with a semitone grid; this is the standard setting
– Scale Snap: the notes snap but only to notes of the scale selected in the

Settings menu (see also Chapter 4)

The Pitch Snap menu

When you activate the scale grid, the Note Ruler becomes a ladder of switches.
Click on a note to select the keynote (i.e. the tonic of the key) using the Shift key
to toggle between the major and minor modes. The pitch of the selected blobs will
adjust automatically, snapping to the nearest note of the selected key. With the
scale grid, you can swiftly adapt a vocal or single-voice instrument line to a differ-
ent key.

When Scale Snap is active, 
clicking a note defines it 
as the tonic of the scale
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The Correct Pitch macro
It is not necessary to correct each out-of-tune note in turn laboriously by hand.
Melodyne plugin offers a macro for the automatic correction of notes. Commence
playback; click somewhere in the background of the editing area (to deselect all
notes); and click the Correct Pitch button in the editing area. 

The Correct Pitch macro

The Correct Pitch dialog opens, displaying two slider controls (or ‘trackbars’). The
upper trackbar is used to specify the extent to which the pitch center of errant
notes should be moved closer to what is assumed to be the intended pitch. The
default setting (100%), you will observe, moves all the blobs to the exact center of
their respective lanes, whilst more moderate settings improve the intonation
without imposing what might seem an overly ‘mechanical’ perfection; at a setting
of 50%, for example, errant notes move halfway towards 'perfection' and no
further. Move the slider and experiment until you find the balance that feels most
satisfying musically. 

Melodyne plugin makes an important distinction between vibrato, which is usually
intentional, and drift, which is not. When a string player or classical guitarist, for
example, shakes his left wrist whilst playing, he does so in order to impart vibrato
(a rapid fluctuation in the pitch of the note that gives the sound greater fullness
and vibrancy). When Melodyne plugin corrects the pitch of out-of-tune notes,
therefore, it is careful to do so without removing the vibrato, which is an important
element of musical expression. When singers drift out of tune on long notes, on
the other hand, this is seldom intentional but usually the result of poor breathing
technique or inattention. For this reason, Melodyne plugin offers you the possibil-
ity of correcting any unintentional drifting from the correct pitch without removing
the vibrato. (You can, of course, remove the vibrato too, if you wish, or tone it
down, but we will deal with that later.) 

If, using the upper trackbar (or slider), you correct only the pitch center, the pitch
drift will remain. You can, however, remove this too with the lower trackbar. Turn

5. Tools and Editing Functions

Melodyne plugin 1.0 user manual



this up to 100% and listen to the results: the fluctuations in intonation disappear
but any vibrato or trill in the signal is retained. This should make clear, if it were
not already apparent, quite how sophisticated Melodyne plugin's analysis of the
signal is and how sensitive the resulting possibilities for intervention are.

The two pitch correction parameters, Correct Pitch Center and Correct Pitch Drift,
are completely independent: i.e. you can set a different intensity (from 0-100%)
for each parameter. If and when you are satisfied with the results, exit with OK; if,
on the other hand, you would prefer to leave things as they were before you
opened the Correct Pitch dialog, exit with Cancel. You can at any time use the
Undo function to reverse changes made by the macro.

Note: if no notes are selected at the time you open the Correct Pitch dialog,
Melodyne plugin understands you to mean ‘correct the pitch of all the notes’; if,
on the other hand, one or more notes are selected, they and only they will be
affected by whatever changes you make. In this context, take note of the various
note selection options offered by the sub-menu of the Edit menu.

Now that you have mastered the basic pitch editing functions of Melodyne plugin,
it should be pointed out that these only work as described for monophonic audio
material. The problem with polyphonic material is that Melodyne plugin has no
way of isolating just one of multiple notes sounding at the same time, so the set of
functions available for editing the pitch are rather more limited. The same applies
to percussive material.

Before we introduce still more functions for the editing of pitch in connection with
the other tools offered by Melodyne plugin, we will deal briefly with a number of
other fundamental and no less fascinating possibilities: those for manipulating the
timing and tempo of audio recordings. 

Editing timing with the Main tool
Melodyne plugin allows you to alter not only the pitch but also the position and
length of individual notes with the Main tool. It is with these possibilities that we
will concern ourselves in the following paragraphs. Transfer a drum loop from the
audio files supplied with Melodyne plugin and use it to try out the techniques we
are about to describe.

Since Melodyne plugin allows you to modify the pitch of individual notes, it must
obviously know where one note ends and the next begins. If the Arrow Tool is
selected in Melodyne plugin’s editing area or the option Always Show Note separa-
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tors is checked in the View menu, this information is displayed in the form of thin
vertical lines. 

A Note separator

You may have noticed as you were editing the pitch of notes that
the appearance of the Main tool (an arrow in most areas of the
screen) changes as it approaches and passes over a blob: in the
center of a blob, it takes the form of the Edit Pitch tool, whereas
when you move it to the beginning or end of the blob, it changes
shape again to become the Edit Time tool. 

With the context-sensitive Edit Time tool at the front of the blob you can move the beginning of a
note and at the back, move its end; in other words alter the position and the length of the note

By clicking with this tool at the beginning of a note and dragging the pointer to
the right or left, you can move the beginning of that note, with the result that as
the note is lengthened, the one that precedes it is shortened, and by the same
amount. One use for this type of function, obviously, is tidying up the timing of
sloppy performances; placing the ending and beginning of notes perfectly on the
right spot.

Note: Please do not confuse moving a note separator (see also the next section of
this chapter) with moving the beginning of a note. When you move a note separa-
tor, you alter the point at which one note ends and the next begins; you are
moving to a certain extent a boundary marker within the note material. Notes are
only then stretched or compressed when you move the beginning or the end of a
note (or notes) yourself by grabbing the blobs and pulling, not the note separators.
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By clicking on this button, you can activate/deactivate the horizontal grid; if you click and hold the
mouse button, a menu opens from which you can select the grid

Being able to stretch and squeeze notes at will has creative implications as well.
To give you an example: select a note; delete it with Delete command from the
Edit menu; and drag the beginning of the following note to the left to fill the gap
you have created. With such techniques, you can vary your recording in a flexible
manner. 

As you stretch or squeeze notes, you will quickly notice that the movements are
quantized. Just as the blobs snap in semitone steps when you alter their pitch,
when you alter their position or length a time grid takes effect. The Edit Time tool
alters the note length in steps that – if the display is big enough – amount to a
maximum of a quarter of the grid shown in the editing area. If the display is not
big enough, only a half or an entire step of the displayed grid is available. If you
zoom a long way out, fewer steps may be displayed than indicated in the menu.
The standard grid shows quarter notes (crotchets); when you alter the length, the
maximum basis is therefore a sixteenth note (semiquaver) grid.

With a switch in the upper right-hand corner of the editing area, you can change
or deactivate the grid. You can also deactivate the grid temporarily by holding the
Alt key, as you can when altering the pitch.

Please note: the note (endings) are always moved by the current step-size, not to
the current grid step – any offset to the grid position is therefore retained when
moving. You can alter this to fine movement if you wish by holding down the Alt
key. 

So far, we have been dealing with altering the length of a note that is followed
directly by another. In this case, it does not matter whether you drag the end of
the first note or the beginning of the second – the effect is the same: in each
case, one note is stretched and the other squeezed by the same amount. In the
case of notes with a blank space to the right of them or either side (because the
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neighboring notes have been deleted, for instance), things are different. If you
drag such a note to the left, it is moved without any length alteration occurring. If
it has a touching "predecessor", this will be stretched or squeezed as a result of
the movement. 

If you drag a free-
standing note from
the front, you move
it without any
change of length
occurring 

If you drag a free-
standing note from
the back, you alter
its length

Pause for a moment to practice moving and resizing notes; if there are no isolated
notes in your file, delete a few notes to give yourself more room in which to work.
For the time being switch off the quantization, allowing more sensitive movements
of blobs. Once the use of the tools has become second nature, move on to the
next paragraph. And please, do not forget that if there are "holes" in the sequence
of notes in the plug-in, the host signal will become audible, if there is audio at
that part of the host track. For your experiments, you should therefore move the
notes of the plug-in to a position along the Time Ruler where there is no audio in
the host or replace the material in the host with "silent" audio.

If you select two or more adjacent notes, they behave as one: if you drag the start
of the group, the entire group moves (in which case, if there is no free space after
the last note, it is stretched or squeezed); if you drag the end of the group to the
right, all members of the group are stretched. 

When stretching a note inside the selection, all the selected notes that lie in front
of the note you have grabbed are to a certain extent grouped together and
stretched proportionately. Also the selection behind the grabbed note is treated as
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a connected group in the same way and squeezed proportionately. The behavior
described applies when you grab the back of the note; if you grab the front of the
note, the entire group is always moved in the same way, regardless of which note
is moved. If the Time Grid is active, the position of the note grabbed is quantized.
The borders of the proportionally stretched notes do not fall in the grid.

When you stretch or squeeze several notes, the notes in front of and after the note grabbed are
treated as a group and stretched/compressed proportionally

Automatic time correction
As with the correction of pitch, Melodyne plugin offers the possibility of correcting
timing errors automatically; this means that instead of laboriously correcting each
note in turn, you can just leave it to the plug-in to make musically intelligent
adjustments to the timing of all or selected notes. 

If you have read the sections above dealing with adjusting the length and position
of notes, you will probably have guessed what this involves: the beginnings of
notes snap to the nearest grid line, whereupon Melodyne plugin alters the length
of the notes, preserving the naturalness — in terms of pitch, timbre and volume –
of the transitions between them.

Try out the function now. Select a few notes the timing of which needs improving
or click in the background of the editing area to cancel the current selection and
click the Quantize Time button.

The window of the 
Quantize Time macro
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You could, if you wanted, exit immediately with OK, effectively correcting all the
timing irregularities in the file or selection with two mouse-clicks, but for the time
being experiment with different settings and try to develop a sense of the musical
implications. If you watch the blobs as you move the Quantize Timing slider, you
will notice that the extent to which they move, stretch or contract in order to
conform more closely to the grid lines is dependent upon the position of the slider. 

Now let’s turn our attention to the Groove Reference buttons above the intensity
control. As you can see, the default option is ‘None’, in which case Melodyne
plugin uses no separate grid but makes an intelligent guess (based upon its prior
analysis of the audio material) as to where each note is supposed to begin and
how long it is supposed to last; usually, you will find, it gets it spot-on and most of
the notes end up in their intended places and with the correct note values; but
occasionally — even Melodyne plugin cannot read minds — you will need to
correct one or two notes by hand, using the Edit Time tool. 

If, on the other hand, you prefer to set the quantization factor (the fineness of the
mesh) by hand, click the appropriate push button; you will observe the effects at
once: grid lines appear at the intervals you have specified and the beginnings and
ends of all selected notes adjust accordingly. Experiment for a few moments with
the quantization functions, as the musical implications of the various options are
more easily understood by listening. 

If you have ever used a MIDI sequencer, you will doubtless have done much the
same thing with MIDI data; but here, there is one important difference: Melodyne
plugin quantizes intelligently, not mechanically, so you are not obliged to set the
quantization factor to the smallest note value of the piece; the fact that you have
set the quantization factor to 1/4 T does not mean that smaller note values will
automatically be rounded up and that all note beginnings will snap to the nearest
grid line (as would be the case with traditional MIDI quantization); instead
Melodyne plugin moves the underlying rhythm and rhythmic emphasis of the notes
to fit in perfectly to the selected grid, allowing smaller note values than those of
the currently selected grid.

"Normal" time-stretching
The playback tempo of audio is variable in Melodyne plugin. The plug-in itself,
however, has no tempo parameter; it follows the tempo of the host program at all
times. If this tempo is altered, the audio material in the plug-in follows suit and is
played back correspondingly faster or more slowly. The sound quality that
Melodyne plugin is able to achieve whilst applying the most extreme time-
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compression and –stretching does, however, astound even hard-bitten audio
professionals and further vindicates the technological approach adopted by
Celemony.
If you wish to use these qualities of Melodyne plugin for normal time-stretching
with an audio file, you can do so like this:

– load the file in question into your host and adjust its tempo setting to the given
tempo of the file;

– transfer the file to Melodyne plugin;
– adjust the tempo of your host until it corresponds to the desired tempo; the

plug-in will now play back the file at this tempo;
– bounce or render (as the case may be) in your host the corresponding segment

as a new audio file on the hard disk.

The file on the hard disk will now have the tempo set in the host at the time of
rendering.

Editing note separators and segments with the Main tool
When you move the Arrow tool to a note separator, it changes shape to become the
Note separation tool. You can use this to move the boundary between notes freely
to the right or left; by ‘freely’, I mean ‘independently of the current quantization
factor’; the boundary does not, in other words, snap to the nearest grid line. 

The Note separation tool and 
the note to be split 

The Arrow tool also becomes the Note separation tool, when you place it just
above or below a note; if you now double-click, the note will be split at that point
and a new note separator created. This in itself will make no difference to the
sound, but allows you, for example, to change the pitch of the first part of the
note (the part to the left of the newly created separator) without changing that of
the second part, or vice versa. Suppose, for example, you wish to introduce an
échappée or a cambiata (or any other ornament for that matter) that isn’t
contained in the original performance. 
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With the Note separation tool, double-click at 
the point where you would like the note to be split;
a new note separator will appear; the note now 
consists of two halves

Now you can grab the second half 
in the middle with the Correct Pitch tool and 
transpose it independently of the first

When you create a division within a note, Melodyne plugin calculates the average
pitch of each of the two parts separately and then tries to select the most appro-
priate split point. This may cause the newly created separator to appear slightly to
the right or left of the point at which you clicked. You can, however, override the
split point chosen by dragging the separator to the exact position you want. 

If you double-click an existing note separator, it will disappear. If you hold the Alt
key and move the pointer to a note separator, it will become the Segment Separa-
tion tool; in this case, if you double-click on the note separator, it will become a
segment separator, which is denoted by a pair of square brackets placed back to
back. But what is a segment separator and what is a segment?

The short answer is this: each time you transfer audio material to Melodyne
plugin, a segment with the corresponding blobs will appear in its editing area. But
the segments serve not simply to distinguish between separate transfers; they also
have more far-reaching implications.

As we have mentioned, and as you have doubtless observed in the course of your
own experiments, contiguous notes in Melodyne plugin remain contiguous: no gap
is created when you shorten a note; instead, the following note begins earlier and
is lengthened to take up the slack. In this way, the legato effect is maintained; but
there is another reason for this that will become clearer if you look again at the
Pitch Curve that Melodyne plugin displays after analyzing monophonic material. 
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In the case of consecutive notes, Melodyne plugin
always takes account of their context

With the human voice and most instruments other than keyboard and percussion
instruments, the start of a note is dependent upon what went before: the note at
the beginning of each phrase is liable to have a sharper and cleaner attack than
the notes that follow, which tend to melt into each other – often with a more or
less pronounced portamento (a gliding from note to note) between them. Depend-
ing upon the nature of the audio file you have loaded, this may be obvious from a
glance at the Pitch Curve. To Melodyne plugin, no note is ‘an island entire unto
itself’ unless it really is isolated to begin with; otherwise, as you move and resize
notes in Melodyne plugin, care is taken to ensure that the transitions retain their
true musical character. Most of the time, this is what you want: to be able to tidy
up the rhythm of a performance without a gap appearing whenever a note needs to
be shortened; but there may be contexts in which you really would prefer to
modify the ending or beginning of a note without this affecting the notes around
it; in other words, to be able to treat each note as an independent entity. This is
where the Segment Separation tool, to which we alluded earlier, comes into its
own. Segment separation works like this: 

The Segment Separation tool and 
a segment separator
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– If you double-click with the Segment Separation tool or the Note separation tool
whilst holding the Alt key on an existing note separator, you turn it into a
segment separator, the symbol for which is a square bracket that is slightly
thicker than a normal note separator. The result is to detach the note in question
from those on either side, allowing you to move it without this affecting them.
When you delete a note from an existing segment, two new segments result: one
on each side of the deleted blob. In the simplest case, a segment consists of a
single blob.

– Double-clicking on a segment separator changes it back into a normal note
separator. But take care: this is only possible in places where the adjacent
note(sections) were touching before the segment separation. If this was not the
case previously, the segment separator between them cannot be removed.
Connecting two adjacent transfers is impossible.

The tools for editing pitch
In Melodyne plugin's Main tool, you have already what is obviously a very powerful
set of editing options; but these are by no means all that Melodyne plugin has to
offer. In this chapter, we will be looking at the other tools, which offer additional
ways of editing audio data. These are accessed by clicking on the user interface or
by right-clicking (or Ctrl-clicking on the Mac) in the editing area.

The first tool in the series after the Arrow tool should have a familiar look to it: it’s
the Edit Pitch tool we met earlier. There, however, it was a context-sensitive form
of the Main tool: it appeared as you moved the arrow over the center of a note and
disappeared just as rapidly when you moved it away. But whereas the Main tool
may be more useful if you are planning to edit the timing as well as the pitch of a
note, the dedicated Edit Pitch tool offers a wider range of functions for correcting
intonation problems alone.

When this tool is active, at the semitone nearest to each blob (or the nearest note
of the selected scale, if the Scale Snap function is active) you will see a little grey
box containing an outline of the same blob. This ‘ghost’ blob indicates where the
real blob would be if the note to which it refers were perfectly in tune (with a
member of the selected scale, if the Scale Snap function is active). To correct the
tuning of a note, simply double-click on the blob with the Edit Pitch tool and it
will snap to the position indicated by the outline (i.e. the ghost blob). To quantize
the pitch of multiple notes in this way, select them and double-click any note in
the selection. 
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Beneath the toolbar, you will see two inspector fields. When you select a note with
the Edit Pitch tool, these display the name of the note and the amount (in cents)
by which its pitch center deviates from the ideal pitch. You can edit these values
directly, in order to transpose the note as desired. This also works when several
notes are selected, though in this case relative values are displayed.

As you move the Edit Pitch tool from the beginning or middle to the end of a note,
it transforms into the Pitch Transitions tool. 

The Pitch Transitions tool

Often the pitch does not change abruptly from note to
note but glides to a more or less noticeable extent.
Melodyne plugin takes note of such transitions,
indicating them by means of an orange line at the end
of the notes. If you click and drag upwards or
downwards on the rear or a blob, the inclination of the
orange line will alter, and with it, the appearance and
sound of the pitch transition between the notes. You
can perform the same modification on several notes
simultaneously. If you wish to create transitions for
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creative reasons or after moving melody tones (in order to smooth out discontinu-
ities, for example) double click on the rear of a blob, which is how you activate
and deactivate the transitions manually. Please note that this is only possible
within segments and not at segment boundaries.

If you click and hold the Edit Pitch tool, two sub-tools appear beneath it. The first
of these is the Pitch Modulation tool. 

The Pitch Modulation tool

The Pitch Modulation tool can be
used to augment or diminish the
amount of vibrato applied to the
selected note or notes. The ampli-
tude of the vibrato applied to this
note, for example … 

… can be reduced to nothing with a
simple drag of the mouse.
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If you carry on dragging in a
downward direction, you can even
phase-reverse the vibrato. 

The Pitch Modulation tool provides an interesting way of modifying one crucial
aspect of the musical expression of a performance; not only can you tone down
the vibrato throughout the entire track, but you can also add it in areas where a
performance perhaps lacks luster or seems thin. You can even split notes in order
to modify the amount of vibrato present in parts of the note only. Double-clicking
a note using the Pitch Modulation tool toggles between the original vibrato and no
vibrato. You can read the existing vibrato intensity from the box beneath the tool
bar or enter a new value if you wish. 

The second tool down is the Pitch Drift tool. ‘Pitch drift’, you will remember, is the
term reserved for divagations in pitch other than vibrato, the difference being
primarily that vibrato is faster. The Pitch Drift tool works like the same parameter
in the Correct Pitch panel with the added possibility of increasing or reversing the
pitch drift. This makes it a more powerful tool for redrawing the pitch envelope of
a note. Double-clicking a note using the Pitch Drift tool toggles between the origi-
nal drift and no drift. You can read the existing drift intensity from the box
beneath the tool bar or enter a new value if you wish. 

Note: Whenever you select one of the Pitch tools from the toolbar, the pitch curve
will be superimposed on the note blobs, even though you may have unchecked
Always Show Pitch Curve in the View menu. 

Tip: It can happen — as a result of drift or vibrato editing or transposition of the
parts — that discontinuities appear in the Pitch Curve, introducing a harshness or
jerkiness to the transitions. That may be the effect you intend, but in the event
that it is not, you can use the Pitch Transition tool to smooth the transitions. What
this does is to introduce a portamento (the intensity of which you can control)
between adjacent notes. 
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The Edit Pitch sub-menu

In the Edit > Edit Pitch cascading submenu, you will find a number of other
functions. The majority, you will observe, are designed to help you reverse
whatever changes you have just made to the selected notes by allowing you to
reset the pitch center, pitch modulation, pitch drift or pitch transition to their
original state; they are more flexible, however, than the Undo button because they
allow you, for example, to reverse the first of a series of four editing steps without
reversing the second, third and fourth. You could, for example, by selecting Edit >
Edit Pitch > Reset Pitch Modulation to Original, restore the original vibrato of the
recording without sacrificing whatever other editing you may have done subse-
quently. The command at the bottom of the Edit > Edit Pitch submenu, Add
Random Offset to Pitch Center, is of a different kind: this can be used to create a
chorus-like effect. If, for example, in your host you make multiple copies of a
vocal part and then modify each of the copies with Melodyne plugin using this
command, by mixing the copies together in the sequencer later, you can create
very natural sounding doubling effects as well as bringing about a "broadening" of
the sound.

The Edit Formants tool
Formants are groups of emphasized harmonics arising from things like the volume
and shape of the resonance chamber; they occur at the same positions within the
frequency spectrum whatever the pitch of the fundamental. Crude transposition
tools, such as samplers, when they transpose the fundamental, transpose the
formants along with it, creating an unnatural timbre. The effect, in the case of a
transposition upwards, is to make it sound as though the speaker or singer had
just inhaled helium; this is known as the ‘Chipmunk effect’. The converse,
produced by transposing formants downwards, is known as the ‘Darth Vader
effect’. Melodyne plugin, as a rule, leaves the formants in place when transposing
audio, yielding considerably more natural results. You may wish on occasion,
however, to make minor or (for special effects) even major adjustments to the
formant structure manually, and this is where the Edit Formant tool comes in. 
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The Edit Formant tool

When you select the Edit Formant tool, a horizontal beam appears in the middle of
each blob. If you drag the beam upwards, you transpose the formants upwards,
giving the voice a more feminine sound; do the same to a musical instrument and
it is equivalent to giving it a smaller resonating chamber, turning a guitar into a
ukulele or a viola into a violin. Transposing the formants downwards is equivalent
to giving an instrument a more voluminous resonating chamber. Again, you can
apply the same changes to all, or only selected, notes and type in the desired
value in cents for the latter, if you prefer that to using the mouse. If you wish to
restore the original formants of a note, simply double-click on it with the Edit
Formant tool. 

The Edit Formant tool is context sensitive: when you hold it over the last part of a
note, it governs formant transitions. 

The Formant Transitions tool

This tool works in much the same way as the tool for pitch transitions. With the
formants, transitions are created automatically whenever you shift the formants of
a note. Here, too, orange lines appear representing a transition. As with the pitch
transition tool, by dragging the mouse pointer upwards or downwards (level with
the end of a note), you can influence the speed of the formant transition to the
next note, with the orange line between the two notes becoming correspondingly
shallower or steeper. Please note that such transitions are only possible within
segments and not at segment boundaries.
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The Edit > Edit Formant cascading submenu offers two options: Reset Formants
to Original and Reset Formant Transition to Default. These commands are useful
because they are independent of the normal Undo function. 

The Edit Formant
submenu

The Amplitude tool
Dynamics, obviously, play a vital part in musical expression, so Melodyne plugin
offers powerful functions to help you edit this aspect of a performance. They are
implemented with the help of the Amplitude tool. If you click on a note with the
Amplitude tool and drag upwards, it becomes louder; downwards, softer; the
amount of change in decibels being indicated in each case in the Inspector area.
As usual: one note, selected notes, or all notes, can be edited with a single
movement of the mouse, or else, if preferred, by entering the desired value in the
edit box beneath the Toolbar. 

The Amplitude tool

As with pitch and formants, you can edit the amplitude transition between notes
to introduce subtle variations into the dynamics of a performance. When, after
dragging to alter the amplitude of a note, you later move the Amplitude tool to the
end of it, orange lines appear indicating the steepness of the amplitude transition
to the next note, which you can then modify by dragging the lines in the normal
way. Please note that such transitions are only possible within segments and not
at segment boundaries.

When you double-click with the Amplitude tool on a blob or a selection of blobs,
the note or notes in question are temporarily muted and the blobs replaced by
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straight lines. Double-clicking a second time, unmutes the notes in question.
Please remember that, unlike the case when you delete notes, when you mute
notes in the plug-in, the result is silence; you do not hear the underlying material
on the host track.

The Edit > Edit Amplitude cascading submenu contains the items you would
expect: commands for resetting the amplitude to the original, the amplitude
transitions to the default and the mute state of the selected notes. 

The Edit Ampli-
tude submenu

Tools for editing timing
The next tool in the toolbar is the Positions/Lengths tool. This works in exactly the
same way as the Main tool when the latter is positioned at the beginning or end of
a note. 

The Time tool

In this case, however, outlines in little gray frames indicate the positions that
Melodyne plugin’s analysis has identified as the ‘ideal’ rhythmic positions for the
blobs; these being also the positions indicated by the notation. The gray frames
also indicate the target positions for quantization that can be carried out using the
Quantize Time macro. 

The following experiment will help you to understand the gray frames. Select the
Time tool and make the notation visible. From the Quantization drop-down menu
to the right of the Bar/Time ruler select a smaller quantization factor or triplets,
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say. Then select all notes and choose Edit > Define Arrangement Tempo >
Reassign Notes to Beats. This will cause the gray frames to jump to new positions
in line with the newly selected quantization factor. 

The little gray frames
represent the target
positions of the notes
for quantization 

These positions of the notes can be changed by dragging a note and moving it in a
horizontal direction — the exact distance being dependent upon the current
quantization factor; the notes in this case are always moved by the current quanti-
zation factor (the horizontal difference between gridlines), not onto the grid.
Double-clicking on a note, or selecting multiple notes and double-clicking any one
of them, will cause the selected note or notes to snap to the nearest grid line and
be stretched or squeezed if necessary. 

From the Edit > Edit Notes Time cascading submenu, you can reset the various
Time parameters of selected notes to their original values.

The Edit Notes Time
submenu

– Reset Relative Time Course to Original re-establishes the original time relation-
ship between notes, leaving their total length unchanged in the event that the
area has been stretched or compressed 
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– Reset Note Time Handles to Original results in whatever changes were made
with the tool in question being undone and the original values restored; if notes
have been squeezed and there is sufficient space available to the right of them,
their original length is restored

– Add Random Offset to Time Course is the companion to Add Random Offset to
Pitch Center (which we met in the Edit > Edit Pitch cascading submenu; both
serve the same purpose: to introduce minor variations to one or multiple copies
of a part, so that when these are played back together, the effect is of a choir (or
‘chorus’) rather than a single voice, or of two or more instruments playing in
unison (like the first violins in an orchestra, for example), rather than a single
violin. 

The Note separation tool
The Note Separation tool has the same function when selected as an independent
tool as it does when it appears automatically as a result of your moving the
context-sensitive Main tool over a note separator.

The Note separation tool

You can use this to move the boundary between notes freely to the right or left; by
‘freely’, we mean ‘independently of the current quantization factor’. If you double-
click, the note will be split at that point and a new note separator created. If you
double-click an existing note separator (without holding the Alt key), it will disap-
pear. If you hold the Alt key and move the pointer to a note separator, it will
become the Segment Separation tool; in this case, if you double-click on the note
separator, it will become a segment separator. The Segment Separation tool is also
available as a sub-tool of the Note separation tool. 

In the Edit > Edit Note separations cascading submenu, you will find the following
commands: 

Separate Note as Trill reinterprets a note containing a strong vibrato as being in
fact a trill and accordingly what was displayed previously as a single note is
broken down into a succession of individual notes alternating in pitch and capable
of being edited individually. Without more, however, the command has no influ-
ence upon the sound. 
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The Edit Note separations
submenu

A note before and after separation with the Separate Note as Trill command

The command Separate Note as Slide is designed to separate notes created, for
example, when a guitarist or bass player slides the finger stopping the string up or
down the string — in other words, it breaks a rising or descending glissando into a
series of discrete semitone steps. Where the potential for a glissando exists, a
continuous rising or falling pitch curve is displayed which, with fretted instru-
ments, may take on a step-like appearance; for it to be recognized and accepted
as such by Melodyne plugin, a slide must cover at least three semitones, with the
first and last notes defining the range of the slide. 

A note before and
after separation with
the Separate Note as
Slide command
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The note range that you wish to treat and separate as a slide should initially be
separated from any preceding or following ‘main note’ and consist of only one
note. Select this slide note followed by the command Separate Note as Slide. The
slide will then be broken down into its constituent notes. 

When you select the Edit Time tool, as described above, little gray frames are
displayed containing the outlines of the notes. These frames indicate the
"presumed" ideal position of the notes, which is that at which they are displayed
at the top of the window in the notation display. When quantizing, the frames
indicate the target position of the notes. If you wish, you can alter these target
positions. To do this, select from the Quantization cascading menu to the right of
the Bar/Time Ruler a different quantization factor (some smaller note value, for
example, or triplets). Then select the desired notes and choose Edit > Edit Note
Separations > Reassign Notes to Beats. The gray frames and the notation will
jump to new positions corresponding to the new target positions for the quantiza-
tion. Tip: the notes themselves are not otherwise altered by this command. All you
are doing is making preparations for a targeted and effective quantization later
with the corresponding macro.

With the commands More Separations and Fewer Separations you can influence
the number of note separations Melodyne plugin detects in the transferred audio
material. If notes that should be separated from one another are not, you can
cause Melodyne plugin to be more sensitive (thereby detecting a greater number
of note separations) with the command More Separations; if there are too many
separations in the material, you can arrive at the opposite result with the Fewer
Separations command. Please note that these two commands can also be used
several times is succession to influence the number of separations.

If you check the option Separate According to Pitch, Melodyne plugin will be more
influenced by the melodic course of the material (and less by the amplitude) when
deciding whether or not to separate notes. Removing the checkmark will weaken
the influence of the melodic course upon the separations. Try out this option (also
in connection with the two commands for more/fewer separations), if you are not
satisfied with the separations detected in more complex material.

It is preferable to use the above-mentioned options before you begin editing the
notes, so that your editing is not disturbed by alterations in the note separations. 
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Correcting the automatic detection 
As we pointed out at the beginning of this manual, for Melodyne plugin to be able
to render audio material malleable and make available its unique editing
functions, the transferred audio file must first be analyzed and interpreted (or
'detected' in Melodyne terminology). This detection process is automatic, requiring
no input from the user. Usually, the results are highly accurate, but with certain
types of material, things can occasionally go wrong: 

– It can happen that the fundamental does not sound with sufficient clarity,
causing Melodyne plugin to mistake the first harmonic for the fundamental itself
(with the result that the note appears in the score as well as in the editing area
an octave higher than you expect); the exact opposite can also happen: you have
a frog in your throat, perhaps, and Melodyne plugin thinks you were singing
Middle C when you thought you were singing the C an octave above. Errors of
intervals other than an octave, incidentally, are very rare. 

– Sometimes notes are not cleanly separated – i.e. two notes appear as a single
note 

Such errors can be corrected manually. For this purpose, Melodyne plugin offers a
special edit mode, called Correct Detection mode, which can you enter directly
from the editing area of Melodyne plugin by clicking the Spanner icon in the
toolbar. When you have made the necessary corrections, you can return to the
normal editing mode just as easily. 

The editing area in 
Correct Detection mode 
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When you are in Correct Detection mode, the blobs in the editing area are yellow
and the pitch curve is displayed in a bolder red. 

In Correct Detection mode, the mouse pointer is again context sensitive: when you
move it to the center of a blob, it becomes the Pitch Correction tool, though notes
here do not snap into position in steps of a semitone; and the effect of dragging a
note to a new location is not to alter its pitch (as would be the case in the normal
editing area) but to trigger a fresh search at the new position; it’s a hint, in other
words; the equivalent of saying: “try looking here”. If Melodyne plugin is success-
ful, the pitch curve will be redrawn to take account of the newly detected note. If,
however, the redrawn pitch curve seems implausible, by double-clicking the blob,
you can trigger a fresh search at the designated location. 

When you move the pointer to a position above or below (or to the beginning or
end of) a note, it changes to the Note separation tool, which you can use if need
be to split (or move the boundaries between) notes as in the ordinary editing area. 

In addition to the detection errors already described, Melodyne plugin sometimes
confuses tonal material with percussive and vice versa: one could think of certain
passages of scat (jazz singers imitating instruments), where different people could
have a legitimate difference of opinion as to whether it was tonal or percussive.
The significance of the decision is threefold: when material is categorized as
‘percussive’, all the notes are displayed at the same pitch; when it is transposed,
the formants are also transposed; and no manual editing of formants is possible. 

If Melodyne plugin's categorization of your material does not correspond with your
own thoughts on the matter, you can simply select manually the playback
algorithm you prefer from the Algorithm menu.
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Appendix

Overview of the Functions of Special Keys and Right-clicking
– Alter the range of pitch or formant controls: Right-click (Ctrl+click on the Mac)

opens context menu

– Reset control to zero: Command+click on the control

– Toggle between major and minor with Scale Snap activated: Shift+click on the
desired keynote in the Note Ruler

– Select tools in editing area: Right-click (Ctrl+click on the Mac) opens the
Toolbar Context Menu

– Toggle context-sensitive Main tool between note and segment separation: Hold
down Alt key as you double-click on the separator

– Navigate using Hand tool in the editing area: Hold down Command key as you
click and drag

– Zoom horizontally and vertically with the Magnifying Glass in the editing area:
Hold down the Command and Alt keys as you click and drag

– Temporarily deactivate horizontal (time) or vertical (pitch) grid whilst editing:
Hold down the Alt key as you click on the blob and move it

– Move the Scroll Slider with higher resolution: Hold down the Alt key as you click
in the middle of the Scroll Slider and drag

Overview of the double-click functions
– With the Main tool above/below a blob: set/remove note separator

– With the Edit Pitch tool in the middle of a blob: quantize to the ideal pitch
displayed

– With the Pitch Transitions tool at the end of a blob: activate/deactivate pitch
transition

– With the Pitch Modulation tool: toggle pitch modulation between 
zero and original

– With the Pitch Drift tool: toggle pitch drift between zero and original

– With the Formant tool: set formant transposition to zero

– With the Amplitude tool: mute / unmute blob

– With the Edit Time tool in the middle of a blob (Position tool): quantize to ideal
position displayed

– With the Note Separation tool: set / remove note separator

– In Correct Detection mode on a blob: trigger new detection of the note in question

– In Correct Detection mode above/below a blob: set/remove note separator
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